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Q1. Which feature allows linking a document 

to a data source to generate personalized 

letters or labels?

(a) Mail Merge

(b) Bookmark

(c) Cross-reference

(d) Table of contents

Q1.
व्यक्तिगि पत्र या लेबल बनाने के ललए कौन
सा फीचर उपयोग होिा है?
(a) मेल मर्ज
(b) बुकमाकज
(c) क्रॉस रेफरेंस
(d) विषय सूची
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➢ Mail Merge connects a document with a data 

source.

➢ It is used to create personalized letters, 

labels, and emails.

➢ It saves time when the same format is needed 

for many recipients.

Explanation:

➢ मेल मर्ज दस्िािेज़ को डटेा स्रोि से र्ोड़िा है।
➢ यह व्यक्तिगि पत्र, लेबल और ई-मेल बनाने में 

उपयोग होिा है।
➢ यह कई प्राप्िकिाजओं के ललए समान फॉमेट 

बनाने में समय बचािा है।
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Q2. In MS Word, the _______ feature is used to 

display content at the top of every page, 

while ____ feature is used to personalize 

letters/emails.

(a) Track Changes; Header

(b) Header; Mail Merge

(c) Mail Merge; Track Changes

(d) Styles; Mail Merge

Q2.
एमएस िडज में हर पेर् के शीषज पर सामग्री
ददखाने और व्यक्तिगि पत्र/ई-मेल बनाने के
ललए कौन से फीचर उपयोग होिे हैं?
(a) टै्रक चेंर्; हेडर
(b) हेडर; मेल मर्ज
(c) मेल मर्ज; टै्रक चेंर्
(d) स्टाइल्स; मेल मर्ज
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➢ Header displays repeated content at the top 

of each page.

➢ Mail Merge creates personalized documents 

from a data source.

➢ Both features are commonly used in 

professional document preparation.

Explanation:

➢ हेडर हर पेर् के शीषज पर दोहराई र्ाने िाली 
सामग्री ददखािा है।

➢ मेल मर्ज डटेा स्रोि से व्यक्तिगि दस्िािेज़ 
बनािा है।

➢ दोनों फीचर पेशेिर दस्िािेज़ बनाने में उपयोगी 
हैं।
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Q3. Which feature in MS Word allows you to 

define and consistently apply formatting 

attributes across sections of a document?

(a) Formatting Painter

(b) Themes

(c) Templates

(d) Styles

Q3.
दस्िािेज़ में एक समान फॉमेट लागू करने के
ललए कौन सा फीचर उपयोग होिा है?
(a) फॉमेदटगं पेंटर
(b) थीम्स
(c) टेम्पलेट
(d) स्टाइल्स
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➢ Styles store predefined formatting for text 

and headings.

➢ They keep font, size, spacing, and appearance 

consistent.

➢ Using styles also helps in creating organized 

documents and tables of contents.

Explanation:

➢ स्टाइल्स टेतस्ट और हेडडगं की पूिजननर्ाजररि 
फॉमेदटगं रखिे हैं।

➢ ये फॉन्ट, आकार, स्पेलसगं और रूप को समान 
रखिे हैं।

➢ स्टाइल्स से दस्िािेज़ और विषय सूची व्यिक्स्थि 
बनिी है।
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Q4. What is the shortcut to open Font dialog 

box in MS Word?

(a) Ctrl + Q

(b) Ctrl + Shift + D

(c) Ctrl + Shift + F

(d) Ctrl + F

Q4.
एमएस िडज में फॉन्ट डायलॉग बॉतस खोलने का
शॉटजकट तया है?
(a) Ctrl + Q

(b) Ctrl + Shift + D

(c) Ctrl + Shift + F

(d) Ctrl + F
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➢ The Font dialog box is used to change font 

settings.

➢ Ctrl + Shift + F is commonly used for font-

related formatting access.

➢ It helps modify font face, size, and other text 

effects quickly.

Explanation:

➢ फॉन्ट डायलॉग बॉतस फॉन्ट सेदटगं बदलने के 
ललए उपयोग होिा है।

➢ Ctrl + Shift + F फॉन्ट से संबंधर्ि फॉमेदटगं के 
ललए उपयोग होिा है।

➢ यह फॉन्ट फेस, आकार और प्रभाि बदलने में
मदद करिा है।
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Q5. What is shortcut key for Paste?

(a) Ctrl + E

(b) Ctrl + V

(c) Ctrl + X

(d) Ctrl + F

Q5.
पेस्ट करने का शॉटजकट तया है?
(a) Ctrl + E

(b) Ctrl + V

(c) Ctrl + X

(d) Ctrl + F
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➢ Ctrl + V inserts copied or cut content at the 

cursor position.

➢ It is one of the most commonly used keyboard 

shortcuts.

➢ Paste works in Word, Excel, browsers, and 

many other applications.

Explanation:

➢ Ctrl + V कॉपी या कट की गई सामग्री को कसजर स्थान 
पर लगािा है।

➢ यह सबसे अधर्क उपयोग होने िाले शॉटजकट में से एक 
है।

➢ पेस्ट Word, Excel, ब्राउज़र और अन्य ऐप्स में काम 
करिा है।

https://play.google.com/store/apps/details?id=co.april2019.pindia


DOWNLOAD PHARMACY INDIA MOBILE APP FROM PLAYSTORE

UPSSSC PHARMACIST

Q6. In MS Word, the shortcut key to split a 

window or remove the split view is:

(a) Ctrl + Alt + V

(b) Ctrl + Alt + N

(c) Ctrl + Alt + O

(d) Alt + Ctrl + S

Q6.
विडंो को विभाक्र्ि या क्स्प्लट व्यू हटाने का
शॉटजकट तया है?
(a) Ctrl + Alt + V

(b) Ctrl + Alt + N

(c) Ctrl + Alt + O

(d) Alt + Ctrl + S
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➢ Alt + Ctrl + S is used to split the Word window.

➢ The split view helps compare or edit different 

parts of a document.

➢ Pressing the shortcut again can remove the 

split view.

Explanation:

➢ Alt + Ctrl + S Word विडंो को विभाक्र्ि करने के ललए 
उपयोग होिा है।

➢ क्स्प्लट व्यू दस्िािेज़ के अलग-अलग भाग देखने या 
संपाददि करने में मदद करिा है।

➢ इसी शॉटजकट से क्स्प्लट व्यू हटाया भी र्ा सकिा है।
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Q7. What is the new feature introduced in 

Office Word 2007 for blogging?

(a) Blogging directly from Word

(b) Document themes

(c) Full Screen Reading view

(d) Quick Styles

Q7.
Word 2007 में ब्लॉधगगं के ललए कौन सा नया
फीचर आया?
(a) सीरे् ब्लॉग ललखना
(b) डॉतयूमेंट थीम
(c) फुल स्क्रीन रीडडगं
(d) क्तिक स्टाइल
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➢ Word 2007 allowed users to create and 

publish blog posts directly.

➢ It made Word useful not only for documents 

but also for online publishing.

➢ The feature supported easy editing before 

posting content online.

Explanation:

➢ Word 2007 में सीरे् ब्लॉग पोस्ट बनाने और प्रकालशि 
करने की सुविर्ा आई।

➢ इससे Word दस्िािेज़ के साथ ऑनलाइन प्रकाशन के 
ललए भी उपयोगी बना।

➢ यह पोस्ट करने से पहले सामग्री को आसानी से 
संपाददि करने में मदद करिा है।
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Q8. What is the primary purpose of the Mail 

Merge feature in MS Word?

(a) Combine multiple documents into one

(b) Generate indexes automatically

(c) Create personalized documents using a 

data source

(d) None of the above

Q8.
MS Word में Mail Merge का मुख्य उद्देश्य तया
है?
(a) कई दस्िािेज़ र्ोड़ना
(b) इंडतेस बनाना
(c) डटेा स्रोि से व्यक्तिगि दस्िािेज़ बनाना
(d) इनमें से कोई नहीं
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➢ Mail Merge uses a main document and a data 

source.

➢ It generates multiple personalized copies 

automatically.

➢ It is commonly used for letters, certificates, 

envelopes, and labels.

Explanation:

➢ मेल मर्ज मुख्य दस्िािेज़ और डटेा स्रोि का 
उपयोग करिा है।

➢ यह अपने-आप कई व्यक्तिगि प्रनियााँ बनािा है।
➢ यह पत्र, प्रमाणपत्र, ललफाफे और लेबल बनाने में 

उपयोग होिा है।
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Q9. To jump the equivalent spaces to the left, 

the key used is:

(a) Shift + Tab

(b) Tab

(c) Enter

(d) Caps lock

Q9.
बाईं ओर समान स्पेस कम करने के ललए कौन
सी कंुर्ी उपयोग होिी है?
(a) Shift + Tab

(b) Tab

(c) Enter

(d) Caps Lock
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➢ Tab moves the cursor or text to the right by a 

set space.

➢ Shift + Tab performs the reverse action and 

moves it to the left.

➢ It is also used to decrease list indent in 

documents.

Explanation:

➢ Tab कसजर या टेतस्ट को ननक्श्चि स्पेस िक दाईं ओर 
ले र्ािा है।

➢ Shift + Tab इसका उल्टा करके बाईं ओर ले र्ािा है।
➢ यह सूची की इंडेंट कम करने में भी उपयोग होिा है।
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Q10.In MS-Word how can you increase the font 

size of selected text by one point every 

time?

(a) Ctrl + ]

(b) Ctrl + [

(c) Ctrl + }

(d) Ctrl + {

Q10.
MS Word में चयननि टेतस्ट का फॉन्ट साइज़
हर बार एक पॉइंट कैसे बढाया र्ा सकिा है?
(a) Ctrl + ]

(b) Ctrl + [

(c) Ctrl + }

(d) Ctrl + {
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➢ Ctrl + ] increases the selected font size by one 

point.

➢ Ctrl + [ decreases the selected font size by one 

point.

➢ These shortcuts are useful for quick text 

formatting.

Explanation:

➢ Ctrl + ] चयननि फॉन्ट साइज़ को एक पॉइंट बढािा है।
➢ Ctrl + [ चयननि फॉन्ट साइज़ को एक पॉइंट घटािा 

है।
➢ ये शॉटजकट िेज़ टेतस्ट फॉमेदटगं में उपयोगी हैं।
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Q11.In MS-Word superscript, subscript, 

outline, emboss, engrave are known as 

_____.

(a) Font effects

(b) Word art

(c) Font styles

(d) Image effects

Q11.
MS Word में superscript, subscript, outline, 

emboss, engrave को तया कहा र्ािा है?
(a) फॉन्ट प्रभाि
(b) िडज आटज
(c) फॉन्ट शैली
(d) इमेर् प्रभाि
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➢ Superscript and subscript are special text 

formatting effects.

➢ Outline, emboss, and engrave also modify the 

appearance of text.

➢ All these options are grouped under font 

effects in Word.

Explanation:

➢ Superscript और subscript विशेष टेतस्ट फॉमेदटगं 
प्रभाि हैं।

➢ Outline, emboss और engrave टेतस्ट के रूप को 
बदलिे हैं।

➢ ये सभी विकल्प Word में फॉन्ट प्रभाि के अंिगजि 
आिे हैं।
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Q12.In Word, paper size with 8.5” × 14” is 

called as _____.

(a) A4

(b) Letter

(c) Legal

(d) A5

Q12.
Word में 8.5” × 14” पेपर साइर् को तया कहा
र्ािा है?
(a) A4

(b) लेटर
(c) लीगल
(d) A5
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➢ Legal paper size measures 8.5 inches by 14 

inches.

➢ It is longer than the standard Letter size.

➢ This size is often used for legal and official 

documents.

Explanation:

➢ Legal पेपर साइर् 8.5 इंच × 14 इंच होिा है।
➢ यह सामान्य Letter साइर् से लंबा होिा है।
➢ यह कानूनी और आधर्काररक दस्िािेज़ों में उपयोग 

होिा है।
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Q13.In MS-Word Portrait and Landscape are 

_____.

(a) Page Orientation

(b) Page Margins

(c) Page Layout

(d) Paper Size

Q13.
MS Word में Portrait और Landscape तया हैं?
(a) पेर् ओररएंटेशन
(b) पेर् माक्र्जन
(c) पेर् लेआउट
(d) पेपर साइर्
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➢ Portrait and Landscape describe the direction 

of the page.

➢ Portrait is vertical, while Landscape is 

horizontal.

➢ These settings are controlled under page 

orientation.

Explanation:

➢ Portrait और Landscape पेर् की ददशा बिािे हैं।
➢ Portrait ऊर्धिाजर्र और Landscape क्षैनिर् होिा है।
➢ ये सेदटगं पेर् ओररएंटेशन के अंिगजि आिी हैं।
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Q14.In Microsoft Word, you can customize 

preset margin settings by selecting _____.

(a) Layout → Margins

(b) Insert → Margins

(c) Review → Margins

(d) Draw → Margins

Q14.
Microsoft Word में माक्र्जन सेदटगं बदलने के
ललए कौन सा विकल्प उपयोग होिा है?
(a) Layout → Margins

(b) Insert → Margins

(c) Review → Margins

(d) Draw → Margins

https://play.google.com/store/apps/details?id=co.april2019.pindia


DOWNLOAD PHARMACY INDIA MOBILE APP FROM PLAYSTORE

UPSSSC PHARMACIST

Q14.In Microsoft Word, you can customize 

preset margin settings by selecting _____.

(a) Layout → Margins

(b) Insert → Margins

(c) Review → Margins

(d) Draw → Margins

Q14.
Microsoft Word में माक्र्जन सेदटगं बदलने के
ललए कौन सा विकल्प उपयोग होिा है?
(a) Layout → Margins

(b) Insert → Margins

(c) Review → Margins

(d) Draw → Margins

https://play.google.com/store/apps/details?id=co.april2019.pindia


DOWNLOAD PHARMACY INDIA MOBILE APP FROM PLAYSTORE

UPSSSC PHARMACIST

➢ Margins control the blank space around the 

page content.

➢ In Word, margin settings are found under the 

Layout tab.

➢ The Layout → Margins option allows preset 

and custom margin settings.

Explanation:

➢ माक्र्जन पेर् सामग्री के चारों ओर खाली स्थान 
ननयंत्रत्रि करिा है।

➢ Word में माक्र्जन सेदटगं Layout टैब में लमलिी 
है।

➢ Layout → Margins से preset और custom 

माक्र्जन सेट ककए र्ािे हैं।
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Q15.What is the primary difference between 

XLOOKUP and VLOOKUP in MS Excel?

(a) XLOOKUP allows reverse and 

horizontal lookups

(b) XLOOKUP requires sorted data

(c) XLOOKUP is available in all Excel 

versions

(d) VLOOKUP can only search vertically

Q15.
MS Excel में XLOOKUP और VLOOKUP में मुख्य
अंिर तया है?
(a) XLOOKUP reverse और horizontal lookup 

कर सकिा है
(b) XLOOKUP को sorted data चादहए
(c) XLOOKUP सभी versions में उपलब्र् है
(d) VLOOKUP केिल vertically search करिा है
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➢ XLOOKUP is more flexible than VLOOKUP.

➢ It can search in both directions and can also 

return values to the left.

➢ VLOOKUP mainly searches vertically from the 

first column of a table.

Explanation:

➢ XLOOKUP, VLOOKUP से अधर्क flexible होिा है।
➢ यह दोनों ददशाओं में search कर सकिा है और बाईं 

ओर की value भी ला सकिा है।
➢ VLOOKUP मुख्यिः table के पहले column से 

vertically search करिा है।
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Q16.How is =SUBTOTAL(9, A1:A10) different 

from =SUM(A1:A10)?

(a) SUBTOTAL includes hidden rows

(b) SUBTOTAL returns average instead of 

sum

(c) SUBTOTAL ignores filtered rows

(d) SUBTOTAL ignores text cells

Q16.
=SUBTOTAL(9, A1:A10) और =SUM(A1:A10) में
तया अंिर है?

(a) SUBTOTAL निपी rows शालमल करिा है
(b) SUBTOTAL average देिा है
(c) SUBTOTAL filtered rows को ignore करिा है
(d) SUBTOTAL text cells को ignore करिा है
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➢ SUM adds all numeric values in the selected 

range.

➢ SUBTOTAL can perform sum while respecting 

filtered data.

➢ When rows are filtered out, SUBTOTAL 

ignores those hidden filtered rows.

Explanation:

➢ SUM चुनी गई range के सभी numeric values 

र्ोड़िा है।
➢ SUBTOTAL filter िाले data के अनुसार sum कर 

सकिा है।
➢ Filter से निपी rows को SUBTOTAL ignore करिा 

है।
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Q17.What feature helps users complete their 

queries?

(a) Voice search

(b) Search history

(c) Manual entry

(d) Autofill suggestions

Q17.
कौन सा फीचर users की queries पूरा करने में
मदद करिा है?
(a) िॉयस सचज
(b) सचज दहस्ट्री
(c) मैनुअल एंट्री
(d) ऑटोकफल सुझाि
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➢ Autofill suggestions predict the remaining 

part of a query.

➢ They are based on common searches and 

previous input patterns.

➢ This feature helps users search faster and 

with fewer typing errors.

Explanation:

➢ Autofill suggestions query का बाकी भाग 
अनुमाननि करिे हैं।

➢ ये common searches और previous input 

patterns पर आर्ाररि होिे हैं।
➢ यह feature िेज़ search और कम typing errors में 

मदद करिा है।
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Q18.What is the maximum number of rows in 

an MS-Excel 2007 worksheet?

(a) 1,048,576

(b) 65,536

(c) 256

(d) 32,768

Q18.
MS Excel 2007 worksheet में अधर्किम rows 

ककिनी होिी हैं?
(a) 1,048,576

(b) 65,536

(c) 256

(d) 32,768
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➢ Excel 2007 greatly increased worksheet 

capacity.

➢ A single worksheet contains 1,048,576 rows.

➢ It also contains 16,384 columns, from A to 

XFD.

Explanation:

➢ Excel 2007 में worksheet क्षमिा बहुि बढाई गई।
➢ एक worksheet में 1,048,576 rows होिी हैं।
➢ इसमें 16,384 columns भी होिे हैं, A से XFD 

िक।
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Q19.Which tab allows you to select the chart 

type and arrange the data source in Excel?

(a) Format tab

(b) Layout tab

(c) Data tab

(d) Design tab

Q19.
Excel में chart type चनुने और data source 

arrange करने के ललए कौन सा tab उपयोग
होिा है?
(a) Format tab

(b) Layout tab

(c) Data tab

(d) Design tab
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➢ The Design tab appears when a chart is 

selected.

➢ It allows changing chart type and selecting or 

arranging chart data.

➢ It is part of Chart Tools in Excel.

Explanation:

➢ Chart select करने पर Design tab ददखाई देिा है।
➢ यह chart type बदलने और chart data चुनने या 

arrange करने में मदद करिा है।
➢ यह Excel के Chart Tools का भाग है।
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Q20.Which Excel feature allows you to set 

criteria for data entry in a cell, thereby 

preventing invalid data?

(a) Conditional Formatting

(b) Filtering

(c) Data Views

(d) Data Validation

Q20.
Excel का कौन सा feature cell में data entry के
ललए criteria set करके invalid data रोकिा है?
(a) Conditional Formatting

(b) Filtering

(c) Data Views

(d) Data Validation
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➢ Data Validation restricts what users can enter 

in a cell.

➢ It can allow only numbers, dates, lists, or 

specific ranges.

➢ This reduces errors and maintains data 

accuracy.

Explanation:

➢ Data Validation cell में डाले र्ाने िाले data को
ननयंत्रत्रि करिा है।

➢ यह केिल numbers, dates, lists या specific 

ranges allow कर सकिा है।
➢ इससे errors कम होिे हैं और data accuracy बनी 

रहिी है।
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Q21.Which Excel function is used to search for 

a value in a range and return a related 

value from another column?

(a) HLOOKUP

(b) SUMIF

(c) INDEX

(d) VLOOKUP

Q21.
Excel का कौन सा function range में value 

search कर दसूरे column से related value 

लौटािा है?
(a) HLOOKUP

(b) SUMIF

(c) INDEX

(d) VLOOKUP
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➢ VLOOKUP searches vertically in the first 

column of a table.

➢ It returns a related value from another 

column in the same row.

➢ It is useful for marksheets, price lists, and 

database lookup tasks.

Explanation:

➢ VLOOKUP table के पहले column में vertically 

search करिा है।
➢ यह उसी row के दसूरे column से related value 

लौटािा है।
➢ यह marksheets, price lists और database lookup 

में उपयोगी है।
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Q22._____ is an equation that performs 

operations on worksheet data.

(a) Formula

(b) Alphabet

(c) Number

(d) Symbol

Q22.
Worksheet data पर operations करने िाला
equation तया कहलािा है?
(a) Formula

(b) Alphabet

(c) Number

(d) Symbol
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➢ A formula is an equation used in Excel 

worksheets.

➢ It can add, subtract, compare, or calculate 

values.

➢ Excel formulas usually begin with an equal 

sign (=).

Explanation:

➢ Formula Excel worksheet में उपयोग होने िाला 
equation होिा है।

➢ यह values को र्ोड़, घटा, compare या calculate 

कर सकिा है।
➢ Excel formulas सामान्यिः equal sign (=) से शुरू

होिे हैं।
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Q23.Which of the following is not an example 

of unstructured data?

(a) Social media posts

(b) Sensor readings

(c) Spreadsheet table

(d) Emails

Q23.
ननम्नललखखि में से कौन सा unstructured data 

का उदाहरण नहीं है?
(a) Social media posts

(b) Sensor readings

(c) Spreadsheet table

(d) Emails

https://play.google.com/store/apps/details?id=co.april2019.pindia


DOWNLOAD PHARMACY INDIA MOBILE APP FROM PLAYSTORE

UPSSSC PHARMACIST

Q23.Which of the following is not an example 

of unstructured data?

(a) Social media posts

(b) Sensor readings

(c) Spreadsheet table

(d) Emails

Q23.
ननम्नललखखि में से कौन सा unstructured data 

का उदाहरण नहीं है?
(a) Social media posts

(b) Sensor readings

(c) Spreadsheet table

(d) Emails

https://play.google.com/store/apps/details?id=co.april2019.pindia


DOWNLOAD PHARMACY INDIA MOBILE APP FROM PLAYSTORE

UPSSSC PHARMACIST

➢ Unstructured data does not follow a fixed 

table format.

➢ A spreadsheet table has rows, columns, and a 

defined structure.

➢ Therefore, a spreadsheet table is structured 

data, not unstructured data.

Explanation:

➢ Unstructured data fixed table format का पालन 
नहीं करिा।

➢ Spreadsheet table में rows, columns और defined 

structure होिा है।
➢ इसललए spreadsheet table structured data है, 

unstructured नहीं।
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Q24.What does the “$” symbol in Excel 

formulas indicate?

(a) Monetary value

(b) Data format

(c) Absolute cell reference

(d) Highlighting cells

Q24.
Excel formulas में “$” symbol तया दशाजिा है?
(a) Monetary value

(b) Data format

(c) Absolute cell reference

(d) Highlighting cells
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➢ The dollar symbol locks a row, column, or 

both in a formula.

➢ This creates an absolute cell reference.

➢ It prevents the reference from changing when 

a formula is copied.

Explanation:

➢ Dollar symbol formula में row, column या दोनों 
को lock करिा है।

➢ इससे absolute cell reference बनिा है।
➢ Formula copy करने पर reference बदलने से बचिा 

है।
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Q25.In Excel sometimes (####) sign is 

displayed in a cell instead of actual data. 

What does it mean?

(a) There is some error

(b) Hidden content

(c) Numbers entered instead of text

(d) Column width is insufficient

Q25.
Excel में कभी-कभी cell में actual data की र्गह
(####) sign ददखाई देिा है। इसका तया अथज
है?
(a) कुि error है
(b) Hidden content

(c) Text की र्गह numbers entered हैं
(d) Column width insufficient है
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➢ The #### symbol usually appears when the 

column is too narrow.

➢ The actual number or date cannot be 

displayed fully.

➢ Increasing the column width shows the 

complete value.

Explanation:

➢ #### symbol सामान्यिः column िोटा होने पर
ददखाई देिा है।

➢ Actual number या date पूरा display नहीं हो पािा।
➢ Column width बढाने पर पूरी value ददख र्ािी है।
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Q26.The ____ function counts the number of 

cells that contain numbers.

(a) COUNT()

(b) COUNTING()

(c) CALCULATE()

(d) NUMBER()

Q26.
Numbers िाले cells धगनने के ललए कौन सा
function उपयोग होिा है?
(a) COUNT()

(b) COUNTING()

(c) CALCULATE()

(d) NUMBER()
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➢ COUNT() counts cells that contain numeric 

values.

➢ It ignores blank cells and text values.

➢ It is useful for counting entries like marks, 

quantities, and serial numbers.

Explanation:

➢ COUNT() numeric values िाले cells को count 

करिा है।
➢ यह blank cells और text values को ignore करिा 

है।
➢ यह marks, quantities और serial numbers धगनने 

में उपयोगी है।
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Q27.What does the formula =ROUND(5.678, 2) 

return in MS Excel?

(a) 5.67

(b) 5.7

(c) 6

(d) 5.68

Q27.
MS Excel में formula =ROUND(5.678, 2) तया
return करिा है?
(a) 5.67

(b) 5.7

(c) 6

(d) 5.68
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➢ ROUND(number, digits) rounds a value to the 

given decimal places.

➢ Here, 5.678 is rounded to two decimal places.

➢ Because the third decimal is 8, the result 

becomes 5.68.

Explanation:

➢ ROUND(number, digits) value को ददए गए 
decimal places िक round करिा है।

➢ यहााँ 5.678 को two decimal places िक round 

ककया गया है।
➢ िीसरा decimal 8 होने से result 5.68 होिा है।
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Q28.Which function key is used to rename the 

selected item?

(a) F1

(b) F3

(c) F2

(d) F4

Q28.
Selected item का नाम बदलने के ललए कौन सी
function key उपयोग होिी है?
(a) F1

(b) F3

(c) F2

(d) F4
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➢ F2 is the common shortcut for renaming 

selected items.

➢ It works in Windows File Explorer and many 

applications.

➢ In Excel, F2 also edits the active cell.

Explanation:

➢ F2 selected item का नाम बदलने का common 

shortcut है।
➢ यह Windows File Explorer और कई applications 

में काम करिा है।
➢ Excel में F2 active cell edit करने के ललए भी 

उपयोग होिा है।
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Q29.In MS Excel, what does the option “Merge 

Across” do?

(a) Creates multiple merged cells for each 

column

(b) Creates merged cells for each row

(c) Creates one merged cell for all rows

(d) Creates five merged cells

Q29.
MS Excel में “Merge Across” option तया करिा
है?
(a) हर column के ललए अलग merged cells 

बनािा है
(b) हर row के ललए merged cells बनािा है
(c) सभी rows के ललए एक merged cell बनािा
है
(d) पााँच merged cells बनािा है
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➢ Merge Across merges selected cells 

separately in each row.

➢ It does not merge all selected rows into one 

large cell.

➢ This option is useful for creating row-wise 

headings.

Explanation:

➢ Merge Across प्रत्येक row में selected cells को 
अलग-अलग merge करिा है।

➢ यह सभी rows को एक बड़ ेcell में merge नहीं 
करिा।

➢ यह row-wise headings बनाने में उपयोगी है।
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Q30.The Input/Output (I/O) management 

technique that temporarily stores 

input/output process data in secondary 

memory for later execution is called ____.

(a) Thrashing

(b) Spooling

(c) Paging

(d) Buffering

Q30.
Input/Output (I/O) management technique 

र्ो later execution के ललए data को secondary 

memory में temporarily store करिी है, उसे
तया कहिे हैं?
(a) Thrashing

(b) Spooling

(c) Paging

(d) Buffering
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➢ Spooling stores I/O jobs temporarily in 

secondary memory.

➢ It allows devices like printers to process jobs 

one by one.

➢ It improves efficiency when fast CPU 

processes wait for slower I/O devices.

Explanation:

➢ Spooling I/O jobs को secondary memory में 
temporary store करिा है।

➢ यह printer र्ैसे devices को jobs one by one 

process करने देिा है।
➢ यह fast CPU और slow I/O devices के बीच 

efficiency बढािा है।
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Q31.Which of the following is an operating 

system in computing?

(a) Compiler

(b) Debugger

(c) Linux

(d) Translator

Q31.
Computing में ननम्नललखखि में से कौन सा
operating system है?
(a) Compiler

(b) Debugger

(c) Linux

(d) Translator
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➢ Linux is an open-source operating system.

➢ It manages hardware, memory, files, and 

processes.

➢ Compiler, debugger, and translator are 

system software tools, not operating systems.

Explanation:

➢ Linux एक open-source operating system है।
➢ यह hardware, memory, files और processes 

manage करिा है।
➢ Compiler, debugger और translator system 

software tools हैं, operating systems नहीं।
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Q32.A social media account that frequently 

interacts with and amplifies 

disinformation using automation is often 

called a/an _____.

(a) Bot

(b) Influencer

(c) Moderator

(d) Hacker

Q32.
Automation का उपयोग करके disinformation 

को interact और amplify करने िाले social 

media account को तया कहिे हैं?
(a) Bot

(b) Influencer

(c) Moderator

(d) Hacker
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➢ A bot is an automated account or program.

➢ Bots can repeatedly post, like, share, or 

amplify content.

➢ Some bots are used to spread misinformation 

or manipulate online discussions.

Explanation:

➢ Bot एक automated account या program होिा है।
➢ Bots बार-बार post, like, share या content amplify 

कर सकिे हैं।
➢ कुि bots misinformation फैलाने या online 

discussions manipulate करने में उपयोग होिे हैं।
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Q33.What is the role of the z/OS operating 

system in IBM mainframe?

(a) Increase CPU speed

(b) Execute diagnostics

(c) Provide user interface

(d) Manage simultaneous users and 

processes

Q33.
IBM mainframe में z/OS operating system का
कायज तया है?
(a) CPU speed बढाना
(b) Diagnostics करना
(c) User interface देना
(d) कई users और processes manage करना
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➢ z/OS is IBM's mainframe operating system.

➢ It supports very large workloads and many 

simultaneous users.

➢ It manages processes, memory, files, security, 

and system resources.

Explanation:

➢ z/OS IBM का mainframe operating system है।
➢ यह बड़ ेworkloads और कई simultaneous users 

को support करिा है।
➢ यह processes, memory, files, security और 

resources manage करिा है।
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Q34.Which Operating System was commonly 

used on RISC-based workstations 

introduced in the 1980s?

(a) UNIX

(b) WINDOWS

(c) Mac OS

(d) MS-DOS

Q34.
1980s में RISC-based workstations पर कौन सा 
operating system commonly use होिा था?
(a) UNIX

(b) WINDOWS

(c) Mac OS

(d) MS-DOS
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➢ UNIX was widely used on technical and RISC-

based workstations.

➢ It supported multitasking, networking, and 

multi-user operations.

➢ Many workstation vendors used UNIX 

variants during the 1980s.

Explanation:

➢ UNIX technical और RISC-based workstations पर 
widely used था।

➢ यह multitasking, networking और multi-user 

operations support करिा था।
➢ 1980s में कई workstation vendors UNIX 

variants use करिे थे।
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Q35.Which part of the operating system 

manages processes (creation, termination, 

scheduling)?

(a) User interface

(b) File system

(c) Device drivers

(d) Kernel

Q35.
Operating system का कौन सा भाग processes 

की creation, termination और scheduling 

manage करिा है?
(a) User interface

(b) File system

(c) Device drivers

(d) Kernel

https://play.google.com/store/apps/details?id=co.april2019.pindia


DOWNLOAD PHARMACY INDIA MOBILE APP FROM PLAYSTORE

UPSSSC PHARMACIST

Q35.Which part of the operating system 

manages processes (creation, termination, 

scheduling)?

(a) User interface

(b) File system

(c) Device drivers

(d) Kernel

Q35.
Operating system का कौन सा भाग processes 

की creation, termination और scheduling 

manage करिा है?
(a) User interface

(b) File system

(c) Device drivers

(d) Kernel

https://play.google.com/store/apps/details?id=co.april2019.pindia


DOWNLOAD PHARMACY INDIA MOBILE APP FROM PLAYSTORE

UPSSSC PHARMACIST

➢ The kernel is the core part of an operating 

system.

➢ It controls process management, memory 

management, and device access.

➢ Process creation, termination, and scheduling 

are kernel-level functions.

Explanation:

➢ Kernel operating system का core part है।
➢ यह process management, memory management 

और device access control करिा है।
➢ Process creation, termination और scheduling 

kernel functions हैं।
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Q36.What type of scheduling is round-robin 

scheduling?

(a) Preemptive scheduling

(b) Linear data scheduling

(c) Non-linear scheduling

(d) Non-preemptive scheduling

Q36.
Round-robin scheduling ककस प्रकार की 
scheduling है?

(a) Preemptive scheduling

(b) Linear data scheduling

(c) Non-linear scheduling

(d) Non-preemptive scheduling
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➢ Round-robin scheduling gives each process a 

fixed time quantum.

➢ If a process is not finished, it is preempted 

and moved to the end of the queue.

➢ Therefore, it is a preemptive CPU scheduling 

method.

Explanation:

➢ Round-robin scheduling प्रत्येक process को fixed 

time quantum देिा है।
➢ Process complete न होने पर उसे preempt करके 

queue के end में भेर् ददया र्ािा है।
➢ इसललए यह preemptive CPU scheduling method 

है।
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Q37.Which company owns the video app 

TikTok?

(a) Open Xcel

(b) Consagous Technologies

(c) ByteDance

(d) Ripen Apps

Q37.
TikTok video app ककस company की है?
(a) Open Xcel

(b) Consagous Technologies

(c) ByteDance

(d) Ripen Apps
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➢ TikTok is owned by the Chinese technology 

company ByteDance.

➢ It is a short-video social media platform.

➢ The app became globally popular for video 

creation and sharing.

Explanation:

➢ TikTok Chinese technology company ByteDance 

की app है।
➢ यह short-video social media platform है।
➢ यह video creation और sharing के ललए globally 

popular हुई।
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Q38.What is the primary purpose of a hashtag 

on social media?

(a) To identify the author of a post

(b) To tag keywords or topics for easy 

search

(c) To classify posts based on their 

sentiment

(d) To indicate sarcasm or irony in a post

Q38.
Social media में hashtag का मुख्य उद्देश्य तया
है?
(a) Post author पहचानना
(b) Easy search के ललए keywords/topics tag 

करना
(c) Posts को sentiment से classify करना
(d) Sarcasm या irony ददखाना
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➢ A hashtag marks a keyword or topic using the 

# symbol.

➢ It groups posts on the same topic together.

➢ Users can search or follow hashtags to find 

related content easily.

Explanation:

➢ Hashtag # symbol से keyword या topic mark 

करिा है।
➢ यह same topic िाली posts को group करिा है।
➢ Users hashtags search या follow करके related 

content आसानी से ढूाँढिे हैं।
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Q39.Identify India’s first indigenously 

developed app store that hosts more than 

965 live apps across various domains and 

public service categories.

(a) Bharatiya AppStore

(b) Seva AppStore

(c) Mobile India AppStore

(d) Mobile Seva AppStore

Q39.
भारि का पहला स्िदेशी रूप से विकलसि app 

store कौन सा है क्र्समें विलभन्न domains और
public service categories में 965 से अधर्क
apps हैं?
(a) Bharatiya AppStore

(b) Seva AppStore

(c) Mobile India AppStore

(d) Mobile Seva AppStore
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➢ Mobile Seva AppStore is an Indian 

government mobile application store.

➢ It hosts public service and government-

related mobile applications.

➢ It supports e-governance access through 

mobile platforms.

Explanation:

➢ Mobile Seva AppStore भारि सरकार का mobile 

application store है।
➢ यह public service और government-related 

mobile apps host करिा है।
➢ यह mobile platforms के मार्धयम से e-governance 

access support करिा है।

https://play.google.com/store/apps/details?id=co.april2019.pindia


DOWNLOAD PHARMACY INDIA MOBILE APP FROM PLAYSTORE

UPSSSC PHARMACIST

Q40.Hangouts is a communication platform 

that combines video calling, voice calling 

and text-based messaging into a single 

service. It is developed by:

(a) Oracle

(b) Google

(c) IBM

(d) Apple

Q40.
Hangouts video calling, voice calling और text 

messaging को र्ोड़ने िाला communication 

platform है। इसे ककसने develop ककया?
(a) Oracle

(b) Google

(c) IBM

(d) Apple
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➢ Hangouts was developed by Google.

➢ It combined messaging, voice calls, and video 

calls.

➢ It was used as a communication tool within 

Google's ecosystem.

Explanation:

➢ Hangouts Google द्िारा developed था।
➢ यह messaging, voice calls और video calls को 

combine करिा था।
➢ यह Google ecosystem में communication tool के 

रूप में उपयोग होिा था।
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Q41.Which social media site primarily 

provides a way to connect with 

professionals and is specially designed for 

exchanging knowledge, ideas, and 

employment opportunities?

(a) Facebook

(b) Instagram

(c) LinkedIn

(d) WhatsApp

Q41.
कौन सी social media site professionals से
रु्ड़ने, knowledge, ideas और employment 

opportunities exchange करने के ललए
designed है?
(a) Facebook

(b) Instagram

(c) LinkedIn

(d) WhatsApp
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➢ LinkedIn is a professional networking 

platform.

➢ It is used for jobs, business networking, and 

career development.

➢ Users can share professional knowledge, 

resumes, and employment updates.

Explanation:

➢ LinkedIn एक professional networking platform 

है।
➢ यह jobs, business networking और career 

development में उपयोग होिा है।
➢ Users professional knowledge, resumes और 

employment updates share कर सकिे हैं।
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Q42.Kevin Systrom and Mike Krieger are the 

founders of which of the following?

(a) WhatsApp

(b) Twitter

(c) Instagram

(d) LinkedIn

Q42.
Kevin Systrom और Mike Krieger ननम्नललखखि
में से ककसके founders हैं?
(a) WhatsApp

(b) Twitter

(c) Instagram

(d) LinkedIn
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➢ Kevin Systrom and Mike Krieger founded 

Instagram.

➢ Instagram began as a photo and video sharing 

platform.

➢ It later became one of the most popular social 

networking apps.

Explanation:

➢ Kevin Systrom और Mike Krieger ने Instagram 

की स्थापना की।
➢ Instagram photo और video sharing platform के 

रूप में शुरू हुआ।
➢ बाद में यह सबसे popular social networking apps 

में से एक बना।
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Q43.Which of the following is an example of a 

G2C (Government to Citizen) e-

Governance service?

(a) Government-to-Government 

communication

(b) Secure document exchange for offices

(c) Digital payment portals for employees

(d) Online tax filing

Q43.
ननम्नललखखि में से कौन सा G2C (Government 

to Citizen) e-Governance service का example 

है?
(a) Government-to-Government 

communication

(b) Offices के ललए secure document exchange

(c) Employees के ललए digital payment portals

(d) Online tax filing
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➢ G2C services connect government directly 

with citizens.

➢ Online tax filing allows citizens to submit tax 

returns digitally.

➢ It is a common e-governance service for 

public convenience.

Explanation:

➢ G2C services government को directly citizens से 
र्ोड़िी हैं।

➢ Online tax filing citizens को tax returns digitally 

submit करने देिी है।
➢ यह public convenience के ललए common e-

governance service है।
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Q44.The architecture of NeGP consists of ____ 

layers.

(a) Three

(b) Four

(c) Two

(d) Five

Q44.
NeGP architecture में ककिनी layers होिी हैं?
(a) Three

(b) Four

(c) Two

(d) Five
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➢ NeGP architecture is commonly described 

using three layers.

➢ These include infrastructure, 

services/support, and application layers.

➢ The layered approach helps deliver e-

governance services efficiently.

Explanation:

➢ NeGP architecture सामान्यिः three layers में 
िखणजि होिा है।

➢ इसमें infrastructure, services/support और 
application layers शालमल हैं।

➢ Layered approach e-governance services को 
efficiently deliver करने में मदद करिा है।
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Q45.Which of the following is an instantaneous 

payment system that operates round-the-

clock, even on holidays?

(a) IMPS

(b) RTGS

(c) UPI

(d) NEFT

Q45.
ननम्नललखखि में से कौन सी instantaneous 

payment system है र्ो holidays में भी 24x7 

काम करिी है?
(a) IMPS

(b) RTGS

(c) UPI

(d) NEFT
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➢ IMPS stands for Immediate Payment Service.

➢ It enables instant interbank fund transfer 

24×7.

➢ It works even on Sundays and bank holidays.

Explanation:

➢ IMPS का अथज Immediate Payment Service है।
➢ यह 24×7 instant interbank fund transfer 

enable करिा है।
➢ यह Sundays और bank holidays पर भी काम करिा 

है।
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Q46.IMPS stands for:

(a) Inter Media Payment Safe

(b) Immediate Policy Service

(c) Immediate Payment Service

(d) Inter Media Payment Service

Q46.
IMPS का full form तया है?
(a) Inter Media Payment Safe

(b) Immediate Policy Service

(c) Immediate Payment Service

(d) Inter Media Payment Service
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➢ IMPS is the abbreviation for Immediate 

Payment Service.

➢ It is an instant electronic fund transfer 

service in India.

➢ The service is available through banks and 

digital payment channels.

Explanation:

➢ IMPS का full form Immediate Payment Service 

है।
➢ यह India में instant electronic fund transfer 

service है।
➢ यह service banks और digital payment channels 

के through उपलब्र् है।
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Q47.Which of the following is NOT an E-

Government?

(a) Business-to-Business (B2B)

(b) Government-to-Government (G2G)

(c) Government-to-Citizen (G2C)

(d) Government-to-Business (G2B)

Q47.
ननम्नललखखि में से कौन e-Government नहीं
है?
(a) Business-to-Business (B2B)

(b) Government-to-Government (G2G)

(c) Government-to-Citizen (G2C)

(d) Government-to-Business (G2B)
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➢ E-government models include G2G, G2C, and 

G2B services.

➢ These involve digital interaction between 

government and stakeholders.

➢ B2B means business-to-business, so it is not 

an e-government category.

Explanation:

➢ E-government models में G2G, G2C और G2B 

services शालमल होिी हैं।
➢ ये government और stakeholders के बीच digital 

interaction को दशाजिे हैं।
➢ B2B business-to-business होिा है, इसललए यह e-

government category नहीं है।
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Q48.Which technology is commonly used in e-

governance to ensure the security and 

authenticity of digital documents?

(a) Distributed Ledger Technology

(b) Digital signature

(c) Cloud computing

(d) Virtual Private Network

Q48.
Digital documents की security और
authenticity सुननक्श्चि करने के ललए e-

governance में कौन सी technology commonly 

used होिी है?
(a) Distributed Ledger Technology

(b) Digital signature

(c) Cloud computing

(d) Virtual Private Network
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➢ Digital signatures verify the identity of the 

signer.

➢ They also ensure that the document has not 

been altered.

➢ This makes them important for secure e-

governance documents.

Explanation:

➢ Digital signatures signer की identity verify करिे 
हैं।

➢ ये यह भी सुननक्श्चि करिे हैं कक document में
बदलाि नहीं हुआ है।

➢ इसललए secure e-governance documents के ललए 
ये महत्िपूणज हैं।
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Q49.Which of the following services are e-

commerce, e-learning, e-banking, m-

commerce, etc.?

(a) Business services

(b) Consumer services

(c) Internet services

(d) E-services

Q49.
E-commerce, e-learning, e-banking, m-

commerce आदद ककस प्रकार की services हैं?
(a) Business services

(b) Consumer services

(c) Internet services

(d) E-services
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➢ Services delivered electronically are called e-

services.

➢ E-commerce, e-learning, and e-banking are 

provided through digital platforms.

➢ They use internet and communication 

technologies to reach users.

Explanation:

➢ Electronically delivered services को e-services 

कहिे हैं।
➢ E-commerce, e-learning और e-banking digital 

platforms से प्रदान होिे हैं।
➢ ये users िक पहुाँचने के ललए internet और 

communication technologies का उपयोग करिे हैं।
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Q50.In the context of Digital Financial Services 

(DFS), what does the acronym AEPS stand 

for?

(a) Automated Electronic Payment 

Services

(b) Aadhaar Enabled Payment System

(c) Advanced Electronic Payment System

(d) Automated Electronic Processing 

Service

Q50.
Digital Financial Services (DFS) के संदभज में
AEPS का full form तया है?
(a) Automated Electronic Payment Services

(b) Aadhaar Enabled Payment System

(c) Advanced Electronic Payment System

(d) Automated Electronic Processing Service
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➢ AEPS stands for Aadhaar Enabled Payment 

System.

➢ It allows banking transactions using Aadhaar-

based authentication.

➢ It is useful for financial inclusion and basic 

banking access.

Explanation:

➢ AEPS का full form Aadhaar Enabled Payment 

System है।
➢ यह Aadhaar-based authentication से banking 

transactions की सुविर्ा देिा है।
➢ यह financial inclusion और basic banking access 

के ललए उपयोगी है।
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➢ Astringents interact with the 

surface proteins of the skin or 

tissues.

➢ They cause these proteins to 

precipitate and coagulate instantly.

➢ This shrinking action effectively 

stops bleeding from minor cuts.

Explanation:

➢ एस्ट्रिंजेंट त्वचा या ऊतकों के सतही
प्रोटीन के साथ पर्पर क्रिया करते
हैं।

➢ वे इन प्रोटीनों को तुरिंत अवक्षपेपत
और जमा देते हैं।

➢ यह ससकुड़ने वाली क्रिया मामलूी कट
से होने वाले रक्तस्राव को प्रभावी ढिंग
से रोकती है।
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